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1 Introduction

Before you upgrade
This chapter explains what you need to know before you upgrade an existing 
IBM® Rational® Synergy for Windows® installation to Rational Synergy Release 
7.1. 

Note  You must read ”Appendix B: Upgrade and Synergy 7.1” on 
page 67 before deciding to upgrade.

Upgrades of Rational Synergy releases prior to 6.4 are not supported by Release 
7.1. To upgrade from a pre-6.4 release, you need to upgrade to one of the releases 
that is supported by Release 7.1 (that is, 6.4, 6.5, or 7.0), and then upgrade to 
Release 7.1 using the document you are now reading. To upgrade from a release 
prior to 6.4, refer to the Release 6.5 Upgrade Instructions, as appropriate. These 
documents are available as explained in “Rational documentation” on page 5. 

Installing Windows clients
If the Synergy server has been or will be installed elsewhere, and you need to 
install only the Windows client, you do not need to read these Upgrade Instructions. 
Instead, follow the steps in the Rational Synergy Installation Guide for Windows. You 
can get this document as explained in “Rational documentation” on page 5.

Readme
The Readme (formerly called the Release Notes) may contain vital news about your 
Rational Synergy software that has been issued after the Rational Synergy Upgrade 
Instructions for Windows for Release 7.1 is published. Review the Readme  before 
upgrading your software. The most current revision of the Readme is available as 
explained in “Rational documentation” on page 5.
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Upgrade instructions
The Upgrade Instructions that you are now reading describe how to upgrade an 
existing 6.4, 6.5, or 7.0 Rational Synergy Windows installation to Rational 
Synergy Release 7.1. These instructions explain how to convert existing Rational 
Synergy databases for use with Rational Synergy Release 7.1. 

Note  To ensure that you have the latest revision of the Rational 
Synergy Upgrade Instructions for Windows, download an electronic 
copy from the IBM Rational Synergy Info Center 
(http://publib.boulder.ibm.com/infocenter/rsdp/v
1r0m0/index.jsp).

In addition to these Upgrade Instructions and the Readme, you will also need 
to read the Rational Synergy Installation Guide for Windows. If you are 
installing Release 7.1 for Windows at a new site, you do not need to read 
these Upgrade Instructions. Instead, follow the steps in the Rational Synergy 
Installation Guide for Windows. To learn how to obtain these documents, 
refer to “Rational documentation” on page 5.

Consulting services
The upgrade process for databases that were customized using a custom model 
database can be complicated, and is not described here. IBM offers consulting 
services and can perform this work for you. For more information, contact your 
local sales representative. If you need contact information, visit the Web site at 
http://www.ibm.com/planetwide/

Contacting IBM Rational Software Support
If the self-help resources have not provided a resolution to your problem, you 
can contact IBM® Rational® Software Support for assistance in resolving 
product issues.

Note  If you are a heritage Telelogic customer, a single reference site 
for all support resources is located at 
http://www.ibm.com/software/rational/support/telelogic/

Prerequisites
To submit your problem to IBM Rational Software Support, you must have an 
active Passport Advantage® software maintenance agreement. Passport 
Advantage is the IBM comprehensive software licensing and software 
2 Rational Synergy Upgrade Instructions, Release 7.1
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Submitting problems
maintenance (product upgrades and technical support) offering. You can enroll 
online in Passport Advantage from 
http://www.ibm.com/software/lotus/passportadvantage/howtoenroll.html

• To learn more about Passport Advantage, visit the Passport Advantage 
FAQs at 
http://www.ibm.com/software/lotus/passportadvantage/brochures_faqs_
quickguides.html.

• For further assistance, contact your IBM representative.

To submit your problem online (from the IBM Web site) to IBM Rational 
Software Support, you must additionally:

• Be a registered user on the IBM Rational Software Support Web site. For 
details about registering, go to http://www.ibm.com/software/support/.

• Be listed as an authorized caller in the service request tool.

Submitting problems
To submit your problem to IBM Rational Software Support:

1. Determine the business impact of your problem. When you report a 
problem to IBM, you are asked to supply a severity level. Therefore, you 
need to understand and assess the business impact of the problem that you 
are reporting.

Use the following table to determine the severity level.

Severity Description

1
The problem has a critical business impact: You are unable to 
use the program, resulting in a critical impact on operations. 
This condition requires an immediate solution.

2
This problem has a significant business impact: The program 
is usable, but it is severely limited.

3
The problem has some business impact: The program is 
usable, but less significant features (not critical to 
operations) are unavailable.

 4
The problem has minimal business impact: The problem 
causes little impact on operations or a reasonable 
circumvention to the problem was implemented.
Rational Synergy Upgrade Instructions, Release 7.1  3
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Chapter 1: Introduction
2. Describe your problem and gather background information, When 
describing a problem to IBM, be as specific as possible. Include all relevant 
background information so that IBM Rational Software Support specialists 
can help you solve the problem efficiently. To save time, know the answers to 
these questions:

• What software versions were you running when the problem occurred?

To determine the exact product name and version, use the option 
applicable to you: 

• Start the IBM Installation Manager and select File > View 
Installed Packages. Expand a package group and select a package 
to see the package name and version number. 

• Start your product, and click Help > About to see the offering 
name and version number. 

• What is your operating system and version number (including any 
service packs or patches)? 

• Do you have logs, traces, and messages that are related to the problem 
symptoms? 

• Can you recreate the problem? If so, what steps do you perform to 
recreate the problem? 

• Did you make any changes to the system? For example, did you make 
changes to the hardware, operating system, networking software, or 
other system components? 

• Are you currently using a workaround for the problem? If so, be 
prepared to describe the workaround when you report the problem.

3. Submit your problem to IBM Rational Software Support. You can submit 
your problem to IBM Rational Software Support in the following ways:

• Online: Go to the IBM Rational Software Support Web site at 
https://www.ibm.com/software/rational/support/ and in the Rational 
support task navigator, click Open Service Request. Select the 
electronic problem reporting tool, and open a Problem Management 
Record (PMR), describing the problem accurately in your own words.

For more information about opening a service request, go to 
http://www.ibm.com/software/support/help.html

You can also open an online service request using the IBM Support 
Assistant. For more information, go to 
http://www.ibm.com/software/support/isa/faq.html.
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Rational documentation
• By phone: For the phone number to call in your country or region, go 
to the IBM directory of worldwide contacts at 
http://www.ibm.com/planetwide/ and click the name of your country 
or geographic region. 

• Through your IBM Representative: If you cannot access IBM 
Rational Software Support online or by phone, contact your IBM 
Representative. If necessary, your IBM Representative can open a 
service request for you. You can find complete contact information for 
each country at http://www.ibm.com/planetwide/.

Rational documentation
The Rational documentation is available in HTML and PDF on the 
documentation DVD, and in PDF on the IBM Rational Synergy Info Center 
(http://publib.boulder.ibm.com/infocenter/rsdp/v1r0m0/index.jsp) 
The documentation can be made available to all users by mounting the DVD on 
a shared drive.
Note that information in the Readme takes precedence over information in the 
documentation or in any of the Rational Synergy Help systems. The most up-to-
date version of the Readme is available to Rational Synergy users on the Rational 
Synergy Info Center.
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Conventions used in this guide
The following conventions are used in this guide.

Fonts and symbols

The following table describes the font and symbol conventions used in this guide.

This document also uses the following conventions:

Note  Contains information that should not be overlooked.

Caution  Contains critical information that must be observed or 
damage to the database or system could result.

Typeface Description

Italic Used for book titles and terminology. Designates names of roles 
(build_mgr), states (working), groups (ccm_root), and users (ccm_user).

Bold Used for items that you can select and menu paths, dialog box 
options and titles, and for emphasis.

Courier Represents command syntax to be entered verbatim, and 
commands on buttons. Also used to signify computer output that 
appears on-screen and the names of files (remexec.cfg), 
attributes (modify_time), commands (ccm start), functions 
(remote_type), types (csrc), and paths c:\users\path).

Courier 
Italic

Represents values in a command string that you supply. For 
example,
c:\users\sue\commands

Greater than (>) Shows a menu path, prompt, or sequence of actions necessary to 
complete an operation. 

Pipe ( | ) Shows that, from the choices shown, you can specify only one 
option or argument.

Brackets ( [...] ) Shows the different options available for a command.

Ellipses ( ... ) Shows that you can specify more than one of a particular type of 
argument.
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Rational documentation
Release-specific instructions
Unless otherwise stated, all instructions in the following chapters are to be used 
regardless of whether you are upgrading from 6.4, 6.5, or 7.0. Whenever 
instructions are specific to certain releases, the releases are noted. 

Command line instructions and examples

Many instructions and examples are shown as entered from a command line 
interface. If you prefer, you can do the equivalent graphical operation. For 
example, you can use Windows Explorer to drag and drop files where these 
Upgrade Instructions use the copy command.
To start a command prompt with the correct path and environment, use the 
Start menu item Start > All Programs > IBM Rational > IBM Rational 
Tools > IBM Rational Synergy 7.1 > CM command prompt. This path 
assumes that you used the default program folder during your installation.

Note  Unless otherwise noted, the examples in this document 
assume that your previous installation directory is Program 
Files\Telelogic\Synergy 7.0 and your Release 7.1 
installation directory is Program Files\IBM\Rational\
Synergy\7.1.
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2 System Requirements
This chapter summarizes the system requirements for the machine on which 
Rational Synergy Release 7.1 is to be installed. For full information, read the 
Rational Synergy Installation Guide for Windows.

Requirements

Disk space requirements

For disk space information, see the Release 7.1 Rational Synergy Installation Guide for 
Windows.
In most cases, the upgrade procedures require that the previous installation 
remain in place while the new installation and upgrade are performed, so 
sufficient disk space for both installations is required.
You must also allow sufficient space or other media for backups.

Windows installation requirements

This section presents the Windows installation requirements.

Windows installation issues

When upgrading to Rational Synergy Release 7.1 for Windows, keep the following 
installation issues in mind:

• Make sure you are using the most recent version of the Rational Synergy 
Installation Guide for Windows.

• When installing a Rational Synergy Main or Additional Windows Server, log 
on as a user who has administrative privileges for the local machine. If you are 
installing an Additional Windows Server, you must also have administrative 
privileges for the machine where the Main Windows Server is installed.

• If you are running Dynamic Host Configuration Protocol (DHCP), you must 
also run Windows Internet Naming Service (WINS) and Domain Name 
Service (DNS).

• The Rational Synergy Windows Server machine must have a static IP address; 
it cannot obtain an IP address from a DHCP server.
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3 Upgrade Methodology
This chapter presents a secure and proven methodology that users typically use to 
upgrade a Rational Synergy installation. Use this methodology when you perform 
the upgrade procedures in the next chapter.

Step 1 – Installing Rational Synergy
Typically, you will want to test the new version of Rational Synergy to make sure it 
meets your needs. Thus, the first step in the upgrade process is to install the new 
version while leaving the old version in place. Follow the sequence presented in 
the appropriate Rational Synergy Installation Guide, including installation of the 
licensing tool and directory service. This must be done on a different machine 
than the one you are currently using for production.

Step 2 – Testing the new installation using a copy of a production 
database

The second step is to test the new installation. For detailed information on testing 
Release 7.1, see Appendix B “B: Upgrade and Synergy 7.1” on page 67

Step 3 – Upgrading the production server and databases
Once you have solved any problems that may have occurred during testing and 
you are satisfied that the new version of Rational Synergy meets your needs, 
update your production server, production database(s), and all of the clients. 
 ©  Copyright IBM Corp. 1992, 2009                                                              Rational Synergy Upgrade Instructions, Release 7.1 11
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4 Upgrade Procedures

Introduction
Two upgrade procedures are presented in this chapter. One is called “Checklist 
for upgrading an existing server” and the other is called “Checklist for upgrading 
to a new server”.
You can have more than one installation, with the same or different versions, of 
Rational Synergy on a given machine, for client and engine software. Your existing 
Synergy databases reside on one or more servers. On Windows, you cannot have 
more than one Rational Synergy Informix server per machine, even for different 
releases of Rational Synergy.  Installing a Rational Synergy 7.1 server on a 
Windows machine will upgrade any previously existing Rational Synergy servers, 
and disable use of those servers under the earlier releases.
As a result, there are two ways to upgrade your databases from earlier releases. 
Do one of the following:

• Create a new 7.1 server on a different machine, then copy your databases to 
this new server, and upgrade them.  Databases may be copied to the new 
server using ccmdb backup or ccmdb pack then ccmdb unpack, or 
using ccmdb dump and ccmdb load in combination with a copy of the file 
system portion of the database. Perform this procedure when you test 
Synergy 7.1, and again when you upgrade production databases for live use 
after you have completed testing. 

OR

• Upgrade an existing 6.4, 6.5, or 7.0 server to 7.1, and upgrade all the 
databases in that server.  Note that installing 7.1 using this procedure will 
immediately perform the server upgrade, and will render the databases 
unusable under previous releases.  Each database on the server must be 
upgraded to 7.1 before it can be used; the databases do not need to be moved 
or copied, since they are already in an upgraded server.  This procedure 
should not be used while testing Rational Synergy 7.1, but may be used after 
you have completed testing on a separate server.

For each server, upgrade the databases on that server using one of these two 
procedures; you can use different procedures for different servers.
“Upgrading an Existing Server” and “Upgrade to a New Server” are outlined in 
two different checklists in this chapter. The following paragraphs explain which 
checklist you need to follow.
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Use the “Checklist for upgrading an existing server” on page 15 if:

• Your operating system is or will be compatible with both your previous 
release of Rational Synergy and Release 7.1, and

• You want to keep the same CM administrator user, and

• You want to upgrade all your databases on the server at the same time, and 
all those databases can be concurrently offline until the upgrade is complete, 
and

• You do not want to create a new Informix database server - you want to 
upgrade your existing server and its databases in place.

Note  You will receive some performance benefits if you choose to 
create an Informix database server. Your databases will be 
unpacked — this causes the database indices to be rebuilt and 
the data to be defragmented, thereby improving performance.

Use the “Checklist for upgrading to a new server” on page 32 if:

• You are testing the new release of Synergy, or

• You need to upgrade to a new operating system that is not compatible with 
your previous release of Rational Synergy, or

• You want to change the CM administrator user, or

• You want to upgrade only some of the databases on a server at this time, 
leaving the others accessed through the previous release, or

• You want to move some databases between file systems, servers, or machines 
(including from UNIX to Windows, or from Windows to UNIX), or

• You want to create a new Informix database server.
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Checklist for upgrading an existing server
If you want to upgrade all your databases on the server at the same time, use the 
following checklist — in the sequence shown — to install the Rational Synergy 
Release 7.1 software and upgrade your database(s) from a previous release.

Caution  Following this procedure and installing the 7.1 software 
on an existing server will immediately perform the server 
upgrade, and will render the databases unusable under 
previous releases.  Each database on the server must be 
upgraded to 7.1 before it can be used; the databases do 
not need to be moved or copied, since they are already in 
an upgraded server. 

Note  To ensure a trouble-free installation, print a copy of this 
checklist, and check off each item as you work through the 
list.

Pre-installation

• Review the “Windows installation requirements” (see page 9)

• “Planning your upgrade” (see page 17)

• If applicable, “Obtaining license information” (see page 17)

• “Saving the previous installation” (see page 18)

• “Backing up all databases” (see page 18)

• “Shutting down the previous Synergy databases” (see page 19)

• If necessary, “Upgrading the operating system” (see page 19)

Installation

• Do not set “The CCM_HOME variable” (see page 19)

• Allocate a “Router port number” (see page 19) 

• “Installing Rational Synergy” (see page 20) 

• Read “How the installation handles configuration, platform values, and 
remote execution files” (see page 20) 
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Post-installation

• If applicable, “Reinstalling PC integrations” (see page 21)

• If applicable, “Merging configuration files” (see page 21)

• “Verifying the installation” (see page 22)

Database upgrade

• Review the “Database upgrade requirements” (see page 23)

• “Upgrading base model databases to 7.1” (see page 23)

• “Testing the database upgrade” (see page 26)

Post-upgrade

• If applicable, “Installing Rational Change 5.2” (see page 28)

• If applicable, read “DCM transfers after upgrade” (see page 28)

• Read about “Purposes, processes, and process rules” (see page 28)

• “Disabling 6.4, 6.5, or 7.0 services” (see page 29)

Troubleshooting

• If you are having problems, review “Troubleshooting” (see page 30)
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Pre-installation
This section explains what you need to do before you install the Rational Synergy 
software.

Planning your upgrade
Before you run Rational Synergy Release 7.1 on a database, that database must 
have been upgraded to the 7.1 level and must contain a 7.1 model.
The Windows server software must be installed and Informix database servers 
must be upgraded by following these instructions. In addition, all Windows users 
must also have the 7.1 client installed. You cannot use older clients with 7.1 
servers (nor vice versa). To learn how to install Windows clients, refer to the 
Rational Synergy Installation Guide for Windows.
Before starting the upgrade, note the server you are upgrading, and list the 
databases on that server. Since the databases will all be unavailable during the 
entire upgrade process, you need to notify the users of those databases and agree 
on a schedule.
Make sure you have all the information you need, including access to the Readme 
for Release 7.1, the Rational Synergy Installation Guide for Windows, and the Rational 
Synergy Administration Guide for Windows, as appropriate.
You should print a copy of the “Checklist for upgrading an existing server” on 
page 15, to mark as you proceed.

Obtaining license information
To install and run the Rational Synergy software, you need a valid IBM® 
Rational® License Server. For detailed information, see the Licensing Guide 
document on the Rational Synergy Information Center 
(http://publib.boulder.ibm.com/infocenter/rsdp/v1r0m0/ind
ex.jsp).
The Rational Directory Service (RDS) is also a prerequisite if you intend to run 
Synergy sessions in Web mode.
For updated server information, see the Rational Directory Server Product Manual, 
available on the Rational Synergy Information Center 
(http://publib.boulder.ibm.com/infocenter/rsdp/v1r0m0/ind
ex.jsp).
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Saving the previous installation
This section explains how to save your previous installation.

Backing up previous installation

Regardless of the release from which you are upgrading, back up your previous 
installation. 

Caution  Backing up your previous installation is an important 
safeguard and should not be skipped.

To back up a previous Windows server installation, save all the files in the 
Rational Synergy installation directory.

Saving previous configuration files

If you use Rational Change, save the previous ptcli configuration file if you 
have modified it. The ptcli file is:

Program Files\Telelogic\Synergy 7.0\etc\ptcli.cfg

Backing up all databases

As the CM Administrator, use the ccmsrv status command to view all of 
your databases. Then, regardless of the release from which you are upgrading, 
back up each of your databases prior to the upgrade.

Note  Backing up your databases is an important safeguard and 
should not be skipped. For more information about backing 
up databases, refer to the “Rational Synergy Database Backup 
and Recovery” section of the Rational Synergy 
Administration Guide for Windows 

If you anticipate that the upgrade will still be running when your regular 
scheduled backups, builds, DCM transfers, and other background jobs are run, 
temporarily disable those scheduled activities. You must remember to turn them 
back on after the upgrade. 
Use your normal procedures for backing up your databases. You may need to use 
the ccmdb backup, ccmdb pack, ccmdb dump, or ccmsrv archive 
commands. If you have a customized model database, remember to back it up as 
well as all your production databases.
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Shutting down the previous Synergy databases
You must first shut down all the databases on the server to be upgraded, and 
then take the server offline.

1. Log on as the CM Administrator on the server being upgraded.

2. Using your previous installation, shut down all current sessions running on 
this server, using the ccmdb shutdown command on each active database.

Start a command window with the path set to your previous installation.

Start > All Programs > Telelogic > Telelogic Lifecyle Solutions Tools 
> Telelogic Synergy 7.0 > CM command prompt
> ccmdb shutdown database_path (for each database)
> ccmsrv offline /y [/s server_name]

Upgrading the operating system

To see a list of operating system versions that are supported by Rational Synergy 
Release 7.1, refer to the Readme. If relevant, upgrade your operating system now, 
after you have shut down your previous installation(s) running on the older 
operating system version, and before you install a new Rational Synergy release 
that requires a newer operating system version.
If your previous release will not run on your upgraded operating system, make 
sure that you have an up-to-date pack file for each of your databases. After you 
have upgraded the operating system and installed Rational Synergy Release 7.1, 
you must unpack your databases to a new database server; follow the “Checklist 
for upgrading to a new server” on page 32.

Rational Synergy installation
Before installing Rational Synergy Release 7.1, make sure your environment 
satisfies all the conditions described in “Windows installation requirements” on 
page 9.

The CCM_HOME variable
Do not set the CCM_HOME environment variable when using or installing 
Rational Synergy on Windows.

Router port number
During the installation process, you are prompted to supply the router port 
number. This can be any unallocated port number. If you used the Rational 
reserved port number of 5412 for Release 6.4, 6.5, or 7.0, you must choose 
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another number for Release 7.1. If you did not use port number 5412, use this 
value. TCP port number 5412 is reserved for Rational by the Internet Assigned 
Number Authority (IANA).

Installing Rational Synergy

Caution  Do not install Rational Synergy Release 7.1 over a 
previous installation. You must keep your previous 
installation(s) (6.4, 6.5, or 7.0) available until the upgrade 
is complete for all servers using that installation.

Follow the instructions in the Rational Synergy Installation Guide for Windows to 
install the license server and Rational Synergy Release 7.1 on all your clients and 
servers.

How the installation handles configuration, platform values, and remote execution 
files 

When you install the software using the procedures described above, the Rational 
Synergy installation program checks the configuration files in your previous 
installation directory. The following actions are taken as a result of this check:

• Rational Synergy Release 7.1 is installed to a separate directory.

• For users running on Informix, the installer copies the previous database 
server configuration files, thus making the previous server available under 
Release 7.1.

• The installer copies commonly modified files (such as ccm.ini) from the 
previous installation to the new one.

• The installer tells you which files must be merged:

• If a given configuration file in your previous installation directory is still 
valid for Release 7.1, it is automatically used in the Release 7.1 
installation directory.

• If a given configuration file in your previous installation directory is no 
longer valid for Release 7.1, it is copied to the Release 7.1 installation 
directory. However, it is given a different name. This new name is 
descriptive and is displayed by the installation program when you install 
Rational Synergy. If you modified any of these files in your old release 
and you want to keep the changes, simply merge your changed files with 
the new Release 7.1 configuration files.

Following is the list of configuration files that are handled as described above 
(paths are relative to the Rational Synergy installation directory):
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etc/ccminit
etc/ccm.ini
etc/remexec.cfg

Post-installation
This section explains what you need to do after you have installed Rational 
Synergy Release 7.1.

Reinstalling PC integrations
If you used a PC integrations product with your previous Rational Synergy 
release, you must install the appropriate integrations release on top of Release 
7.1.
You do not need to reinstall PC Integrations types into any existing databases. 
The database upgrade process described in these Upgrade Instructions preserves 
the PC integration types.

Merging configuration files

If you have not already done so, you should merge the files identified in “How 
the installation handles configuration, platform values, and remote execution 
files” on page 20.
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Verifying the installation
Verify correct installation by unpacking a test database into the directory set up 
for Rational Synergy databases, on the database server machine. If any of the 
following steps fail, contact Contacting IBM Rational Software Support as 
described on page 2.
To verify the installation, do the following:

1. Unpack a test database.

Log on as the CM Administrator on the Rational Synergy server, and unpack 
a test database. Rational Synergy databases must be on an NTFS file system, 
and the ccmdb unpack command requires a UNC path name for the 
database to be created. For more information on the ccmdb unpack 
command, refer to the Rational Synergy Administration Guide for Windows.  
> ccmdb unpack "Program 
Files\IBM\Rational\Synergy\7.1\packfiles\training.cpk" /t 
\\server\share\testdb

2. Start a Rational Synergy session in Traditional mode on the test database.

• On the Windows taskbar, click Start > All Programs > IBM Rational 
> IBM Rational Tools > IBM Rational Synergy 7.1 to display the 
Start Rational Synergy dialog box.

Note The Start menu folder shown in the path above is the 
default program folder. Your folder may be different based on 
where you installed the program.

When the Start Rational Synergy dialog box is displayed, enter the CM 
Administrator name and password, type the path to the test database in the 
Database Path text box, and the name of this machine in the Engine Host 
text box. Click Start to start the session.

The installation is complete when the session(s) start. Stop the sessions by 
clicking on the close icon in the top right of the Rational Synergy client window, 
or by using the Task > Exit menu item.
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Upgrade databases to Rational Synergy Release 7.1
This section explains how to upgrade your Rational Synergy databases to 
Rational Synergy Release 7.1 when using the procedure “Upgrading an Existing 
Server.”

Database upgrade requirements

Before you can use your Release 6.4, 6.5, or 7.0 databases with Rational Synergy 
Release 7.1, you must upgrade these databases. Moreover, before you upgrade 
these databases, you must have installed Rational Synergy Release 7.1.
This document describes how to upgrade Rational Synergy 6.4, 6.5, or 7.0 base 
model databases – databases that have not been customized via a model install 
from a model database. Databases customized using the Type Definition dialog 
box, or by modifying control files, etc., are still considered base model databases, 
and should be upgraded using these procedures.
To upgrade model databases and databases that have been customized via a 
model install, contact IBM Rational Software Support.

Upgrading base model databases to 7.1

Perform the following steps for each Windows production database to be 
upgraded.

1. Log on to the server machine as the CM Administrator.

2. Save manual customizations.

The upgrade program automatically saves your previous pt and notify 
directories, and your previous Windows migrate.rul file.

If you made changes to other database-specific configuration files, save 
those changes by making a backup copy of the files. 

3. Run the upgrade program.
> ccmdb upgrade database_path1 databasepath2 . . . >logfile

The database_path must be supplied as a UNC path.

You can specify any number of database_path UNC paths for a list of 
databases to be upgraded. The upgrade program can take anywhere from a 
few minutes for a very small database to many hours for a very large 
database.

For more details about the upgrade program, see ”Appendix A: The 
Upgrade Program” on page 63.
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4. The upgrade program unprotects the databases. You should re-protect the 
databases, using ccmdb protect database_path, until you have 
completed the steps below and tested the result.

5. Once the database upgrade is complete, look through the logfile that you 
created in step 3 and the ccm_upgrade.log file created by the ccmdb 
upgrade command to locate any error messages or warnings that require 
further action.

6. Restore manual customizations.

If you made changes to database-specific configuration files, such as triggers, 
merge the changes you saved in step 2 into the converted databases. 

Caution  You must merge these files with the Release 7.1 versions, 
not just copy back your saved versions.

7. Save the following directories to a separate directory for future reference.

The ccmdb upgrade program saves selected files from your database before 
installing the new 7.1 files. After ccmdb upgrade completes for the first item 
on a database, save these files elsewhere to prevent them from being 
overwritten by future upgrades. The saved files reside under the database 
path.

Save the content of the following directories:
• old_types
• oldbin
• oldpt
• lib/oldnotify

Save the content of the following files:
• lib/Unix/migrate.old
• lib/Windows/migrate.old

8. Modify standard types.

If any standard types were modified in the database since the previous model 
install, they are automatically exported to the 
database_path\old_types directory. Compare any modified type with 
the corresponding Release 7.1 type as follows: 

a. Start Synergy Classic and use either the CLI or the GUI.
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b. Export the Release 7.1 type using the following command:
ccm typedef /export type_name /dir to_path 

c. Compare the Release 7.1 type to the corresponding type that is in the 
database_path\old_types directory. You can do this by 
comparing XML files.

d. If you need to reapply changes, start a session on the upgraded database 
using Release 7.1, start the Type Definition dialog box, and reapply the 
changes. Do not perform a type definition import of the standard type 
from a prior release into the upgraded database without examining and 
understanding all of the differences. In doing so, other properties of the 
type definition may revert to their definition from a prior release and 
these could be incompatible with Release 7.1.

9. Merge task attribute customizations.

Settings and possible values for some task attributes are held in the pt 
directory of your databases.

After you have used these Upgrade Instructions to upgrade a database from 
Release 6.4, 6.5, or 7.0 to Release 7.1, you have two pt directories under that 
database. To complete the upgrade, you must reapply the changes you made 
in your previous release to the new database_path\pt directory. Your 
previous pt directory was saved in database_path\oldpt.

Caution  You must merge these files with the Release 7.1 versions, 
not just copy back your saved versions.

You must also remember to restore any changes you made to the task type, 
such as adding attributes to the source_attrs attribute.

10. Merge notify customizations.

After you have used these Upgrade Instructions to upgrade a database from 
Release 6.4, 6.5, or 7.0 to Release 7.1, you have two notify directories 
under that database. To complete the upgrade, you must reapply the changes 
you made in your previous release to the new database_path\notify 
directory. Your previous notify directory was saved in 
database_path\oldnotify.

Caution  You must merge these files with the Release 7.1 versions, 
not just copy back your saved versions. It is very 
important that you do this merge if you use Rational 
Change, because it requires modified notify scripts.
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11. Set site default settings.

If you are using settings other than the default settings for the following 
options, you need to specify the defaults for your site. These settings apply 
across all sessions for all interfaces. Edit the following entries in the 
ccm.ini file to set defaults:
baseline_template
baseline_template_date_format
baseline_template_repl_char
include_required_tasks
project_subdir_template
wa_path_template

For more information about these settings, see the Defaults section of the 
Synergy CLI Help, Web mode.

12. Upgrade DCM settings.

For complete information about upgrading a DCM database, see “Upgrading 
a DCM Cluster” on page 59.

Your database is now upgraded to Release 7.1.

Testing the database upgrade

You have completed the upgrade to your production database. To test the result, 
start a Rational Synergy session and perform a number of operations. A short list 
of operations is given below.
If the database was manually protected after the upgrade, you must unprotect it 
before you can start a session. To run your tests, unprotect the database, start a 
session, then immediately protect the database again so that developers do not 
use the database until you have confirmed that it is working correctly. Repeat 
these steps each time you start a session for testing or for the post-upgrade 
actions described in the next section.
Start a Rational Synergy session on the upgraded database. On the Windows 
taskbar, click Start > All Programs > IBM Rational > IBM Rational Tools > 
IBM Rational Synergy 7.1 to display the Start Rational Synergy dialog box.
Test at least the following functionality in each upgraded database:

• Navigate through the explorers and Work pane in Rational Synergy.

• Create a new project.

• Create a task and assign it to yourself.

• Create one or more source objects in the new project.
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• Check in one or more of those source objects.

• Check out one or more of the source objects you just checked in.

• Open the history of one or more of these source objects.

• Use an earlier version of one of the checked-out source objects.

• Update your project, and verify that the version you used is replaced.

• Make sure you can build your own product using your normal build scripts.

• Sync your work area with your database

See ”Appendix B: Upgrade and Synergy 7.1” on page 67 for detailed information 
about testing the upgrade.
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Post-upgrade
This section explains in detail some things you may need to do once your 
upgrade is complete.

Installing Rational Change 5.2

If you use Rational Change with this database, install Rational Change 5.2. Earlier 
releases of Rational Change are not compatible with Rational Synergy 7.1. For 
detailed instructions, refer to the Rational Change Installation Guide for Windows.
Note that you must create or upgrade at least one database before you install 
Rational Change 5.2, because Rational Change requires access to a Rational 
Synergy database.
If you saved a modified copy of the previous ptcli configuration file as 
described in “Saving previous configuration files” on page 18, you should merge 
it at this time. The ptcli file is:

Program Files\IBM\Rational\Synergy\7.1\etc\ptcli.cfg

DCM transfers after upgrade

Rational Synergy 7.1 supports DCM transfers to and from releases 6.4 SP1, 6.5 
SP2, 6.5a, 6.6a, and 7.0. Patches to these releases are required for DCM 
compatibility. For additional information, see the Rational Synergy Readme for 
Release 7.1 and the product README files for patches to the earlier releases.
For complete information about upgrading a DCM database, see “Upgrading a 
DCM Cluster” on page 59.

Purposes, processes, and process rules

In Release 6.5, process rules replaced the objects previously known as update 
templates and reconfigure templates. Release 6.5 also introduced the concept of a 
process, which is a collection of process rules, and renamed some existing 
purposes. For more information, read the "Updating Scripts to Work with 
Rational Synergy 7.1" on page 55, the Rational Synergy Help, and the Build Manager’s 
Guide.
Upgrading to 7.1 creates or renames the standard purposes. If you have modified 
any of the standard purposes, your modified copy will be renamed, starting with a 
prefix “Saved”.
After the database upgrade has completed, you should examine any modified 
purposes and process rules, and adjust them as required. Create one or more 
processes with your preferred set of process rules.
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Note  Rational Synergy does not replicate processes or process 
rules from 7.0 to 6.4 or earlier releases, nor does it replicate 
reconfigure templates or update templates from 6.4 or earlier 
releases to 7.1. If you used DCM to centrally administer 
update templates in earlier releases, you will have to upgrade 
all 6.4 or earlier databases in the cluster to achieve the same 
effect with process rules in Release 7.1.

Disabling 6.4, 6.5, or 7.0 services

The upgrade process stops and renders unusable the previous release on the 
upgraded server. You should disable 6.4, 6.5, or 7.0 services using the following 
steps:

1. On the taskbar, click Start > Control Panel > Administrative Tools > 
Services to display the Services window.

2. Repeat the following steps for each 6.4, 6.5, or 7.0 Synergy service:

a. Right-click the service entry, and select Properties from the pop-up 
menu.

b. In the General tab, change the Startup type to Disabled.

Caution  Do not delete the previous Rational Synergy installation 
directory. If you remove it incorrectly, your upgrade could 
be compromised. To learn about additional reasons for 
saving your previous installation, see Appendix B “B: 
Upgrade and Synergy 7.1” on page 67.

Installing Windows clients

If needed, install Windows clients for Rational Synergy Release 7.1. You do not 
need to uninstall clients for previous releases, but you may do so if there is no 
need to access any databases still using the previous release.
For detailed instructions, see the Rational Synergy Installation Guide for Windows. To 
learn how to obtain this document, see “Rational documentation” on page 5.

Testing Web mode
Previous examples in this document have started Rational Synergy sessions in 
Traditional mode. If your site will start Rational Synergy sessions in Web mode, 
be sure to test that with your upgraded database. The following shows how.

1. Run the ccm monitor command and check that the appropriate CCM 
server is running. If it is not, start it using the ccm_server command. Note 
Rational Synergy Upgrade Instructions, Release 7.1  29



Chapter 4: Upgrade Procedures
the server URL shown in the output after running the ccm monitor 
command.

2. In your browser, enter protocol://server:port/admin, where the 
protocol (http or https), server and port are those in the server URL.

3. When prompted, enter the administrator password.

4. On the Database tab, check that the database you want to test is listed as 
connected to this server. If it is shown as connected to a different server, you 
should either use the other server, or use the Web page to change the server 
for the database.

5. Start a Synergy session using the server URL you have just verified:
cmsynergy /d database_path /s server_url

Note that you can tell whether a Synergy session was started in Web mode or 
Traditional mode by looking at the lower right corner of the Synergy Work 
pane. 

You will see a message similar to the following if the session was started in 
Traditional mode: 
User sue on database /vol/ccm_docs/ccm_docs using 
server pacifica

You will see a message similar to the following if the session was started in 
Web mode: 
User sue on database /vol/ccm_docs/ccm_docs using 
server http://cmserver:8400

Making databases available for use
Once you have completed the upgrade, tested the results, and performed any 
required post-upgrade actions, your upgrade is complete. If you protected the 
databases during the upgrade, test, or post-upgrade process, unprotect them now. 
You should let the users know the database are ready for use, but remember that 
users’ client software must also be upgraded.

Troubleshooting
If you have difficulties with a command or process, or if you receive an error 
message that you do not understand, do the following:

• Refer to the troubleshooting information on the IBM Rational Support site 
and the Rational Synergy Administration Guide for Windows, as appropriate.
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This site also contains Frequently Asked Questions (FAQs), technical 
bulletins, and a Discussion Forum. 

• If you still have questions, contact Contacting IBM Rational Software 
Support, as explained on page 2.
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Checklist for upgrading to a new server
If you want to upgrade your databases at different times, or move some databases 
to new servers, use the following checklist — in the sequence shown — to install 
the Rational Synergy Release 7.1 software and upgrade your database(s) from a 
previous release.

Note  To ensure a trouble-free installation, print a copy of this 
checklist, and check off each item as you work through the 
list.

Pre-installation
• Review the “Windows installation requirements” (see page 9)

• “Planning your upgrade” (see page 34)

• If applicable, “Obtaining license information” (see page 34)

• “Saving the previous installation” (see page 35)

• “Backing up all databases” (see page 35)

• “Packing or dumping previous databases” (see page 36)

• In some situations, “Shutting down the previous release” (see page 37)

• If necessary, “Upgrading your operating system” (see page 39)

Installation

• Do not set “The CCM_HOME variable” (see page 40)

• Read about “Changing your CM administrator user” (see page 40)

• Allocate a “Router port number” (see page 40)

• “Installing Rational Synergy” (see page 40)

• Read “How the installation handles configuration, platform values, and 
remote execution files” (see page 41)

• “Creating a database server” (see page 41)
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Post-installation
• If applicable, “Reinstalling PC integrations” (see page 42)

• If applicable, “Merging your configuration files” (see page 42)

• “Verifying the installation” (see page 43)

Database upgrade

• Review the “Database upgrade requirements” (see page 44)

• “Unpacking or loading previous databases” (see page 44)

• “Upgrading base model databases to 7.1” (see page 45)

• “Testing the database upgrade” (see page 49)

Post-upgrade

• If applicable, “Installing Rational Change 5.2” (see page 50)

• If applicable, read “DCM transfers after upgrade” (see page 50)

• Users might have to “Updating work areas” (see page 50)

• Read about “Purposes, processes, and process rules” (see page 50)

• When no longer needed, “Disabling 6.4, 6.5, or 7.0 services” (see page 51)

• When no longer needed, “Removing the previous installation” (see page 51)

• If applicable, “Installing Windows clients” (see page 52)

• “Making databases available for use” (see page 53)

Troubleshooting
• If you are having problems, review “Troubleshooting” (see page 53)
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Pre-installation
This section explains what you need to do before you install the Rational Synergy 
software.

Planning your upgrade

Before you run Rational Synergy Release 7.1 on a database, that database must 
have been upgraded to the 7.1 level and must contain a 7.1 model.
The Windows server software must be installed and Informix database servers 
must be created by following these instructions. In addition, all Windows users 
must also have the 7.1 client installed. You cannot use older clients with 7.1 
servers (nor vice versa). To learn how to install Windows clients, refer to the 
Rational Synergy Installation Guide for Windows.
Before starting the upgrade, decide on where the new server is to be and what its 
configuration is. Make a list of the databases to be moved to that new server as 
they are upgraded. Since those databases will be unavailable during the upgrade 
process, you need to notify the users of those databases and agree on a schedule.
You can move a database from Windows to UNIX by packing on Windows and 
unpacking on UNIX, but you must then run ccmdb upgrade -w. See 
”Appendix A: The Upgrade Program” on page 63 for more information on the 
upgrade command.  You can move a database from UNIX to Windows by 
packing on UNIX and unpacking on Windows (either before or after upgrading 
the UNIX database).
Make sure you have all the information you need, including access to the Readme 
for Release 7.1, the Rational Synergy Installation Guide for Windows, and the Rational 
Synergy Administration Guide for Windows, as appropriate.
You should print a copy of the “Checklist for upgrading to a new server” on page 
32, to mark as you proceed.

Obtaining license information
To install and run the Rational Synergy software, you need a valid IBM® 
Rational® License Server. For detailed information, see the Licensing Guide 
document on the Rational Synergy Information Center 
(http://publib.boulder.ibm.com/infocenter/rsdp/v1r0m0/ind
ex.jsp).
The Rational Directory Service (RDS) is also a prerequisite if you intend to run 
Synergy sessions in Web mode.
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For updated server information, see the Rational Directory Server Product Manual, 
available on the Rational Synergy Information Center 
(http://publib.boulder.ibm.com/infocenter/rsdp/v1r0m0/ind
ex.jsp).

Saving the previous installation

This section explains how to save your previous installation.

Backing up previous installation

Regardless of the release from which you are upgrading, back up your previous 
installation. 

Caution  Backing up your previous installation is an important 
safeguard and should not be skipped.

To back up a previous Windows server installation, save all the files in the 
Rational Synergy installation directory.

Saving previous configuration files

If you use Rational Change, save the previous ptcli configuration file if you 
have modified it. The ptcli file is:

Program Files\Telelogic\Synergy 7.0\etc\ptcli.cfg

Backing up all databases
As the CM Administrator, use the ccmsrv status command to view all of 
your databases. Then, regardless of the release from which you are upgrading, 
back up each of your databases prior to the upgrade. 

Note  Copying your databases is both an important safeguard and a 
critical part of this upgrade process, and must not be skipped. 
For more information about backing up databases, refer to 
the “Rational Synergy Database Backup and Recovery” section 
of the Rational Synergy Administration Guide for Windows 

If you anticipate that the upgrade will still be running when your regular 
scheduled backups, builds, DCM transfers, and other background jobs are run, 
temporarily disable those scheduled activities. You must remember to turn them 
back on after the upgrade. 
You may use your normal procedures for backing up your databases, but read the 
next section about the need for a copy of the databases. If you have a customized 
model database, remember to back it up as well as all your production databases.
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Packing or dumping previous databases
You must copy your databases from your previous release into a Rational Synergy 
7.1 server. Use ccmdb backup (or ccmdb pack) and ccmdb unpack. If your 
normal backup procedure is to use ccmsrv archive or some other method, 
you must use ccmdb backup, ccmdb pack, or ccmdb dump instead of or in 
addition to your normal backup procedures.
If a database is too large to be packed, you must back up the metadata and file 
system separately.  Back up the metadata using ccmdb dump; note that ccmsrv 
archive is not suitable for this purpose. Back up the file system portion of the 
database using any appropriate tool. Note that this step should be performed 
using your previous release.

1. Start a command window with the path set to your previous installation.

Start > All Programs > Telelogic > Telelogic Lifecyle Solutions Tools 
> Telelogic Synergy 7.0 > CM command prompt

2. Copy the database directory using a tool of your choice.

3. Dump the metadata.
> ccmdb dump unc_database_path /to dumpfile
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Shutting down the previous release
Note  In most cases, you need not shut down your previous 

release(s) of Rational Synergy before installing Release 7.1. 
You must shut down your previous release only if you must 
delete and replace your existing Informix database server 
instead of creating an entirely new and separate Informix 
database server (not recommended).Before you delete a 
previous installation, be sure to read ”Appendix B: Upgrade 
and Synergy 7.1” on page 67.

To shut down a previous release, perform the following steps:

1. Log on as the CM Administrator on the server being upgraded.

2. Using your previous installation, shut down all current sessions running on 
this server, using the ccmdb shutdown command on each active database.

Start a command window with the path set to your previous installation.

Start > All Programs > Telelogic > Telelogic Lifecyle Solutions Tools 
> Telelogic Synergy 7.0 > CM command prompt
> ccmdb shutdown database_path (for each database)
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Deleting databases from the previous Informix database server

Caution  If you have shut down your previous release, and you want 
to reuse the disk space used by your previous Informix 
database server, you must first delete all databases from 
the previous server.Do not delete your databases from the 
previous Informix database server until you are sure you 
have good backups.

To delete all databases from your previous server:

1. Make sure that you have a successful backup of all your databases.

2. Log on as the CM Administrator on the database server machine.

3. Point to your old installation directory.

Start a command window with the path set to your previous installation.

Start > All Programs > Telelogic > Telelogic Lifecyle Solutions Tools 
> Telelogic Synergy 7.0 > CM command prompt

4. Get a list of databases.
> ccmsrv status [/s servername]

5. Remove each database.
> ccmdb delete unc_database_path
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Removing the previous installation and database server

If you no longer need your old release or if you want to delete your database 
server and reuse its disk space, you can uninstall the previous release now. 
During the uninstall, you may select the option to delete the Informix database 
server; this is safe provided you have taken a copy of all the databases on the 
server as described earlier.

Caution  Do not delete the previous Rational Synergy installation 
until you are sure you have a good backup or another 
copy of the previous release. To learn about additional 
reasons for saving your previous installation, see 
Appendix “B: Upgrade and Synergy 7.1” on page 67.

Upgrading your operating system

To see a list of operating system versions that are supported by Rational Synergy 
Release 7.1, refer to the Readme.
If relevant, upgrade your operating system now, after you have shut down your 
previous installation(s) running on the older operating system version, and 
before you install a new Rational Synergy release that requires a newer operating 
system version.
Alternatively, set up a new machine with the newer operating system, and 
upgrade to Rational Synergy Release 7.1 on that system following this checklist.
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Rational Synergy installation
Before installing Rational Synergy Release 7.1, make sure your environment 
satisfies all the conditions described in “Windows installation requirements” on 
page 9.

The CCM_HOME variable
Do not set the CCM_HOME environment variable when using or installing 
Rational Synergy on Windows.

Changing your CM administrator user
You may change your CM administrator user on upgrade only if you are installing 
the new release on a different machine from your previous installation. For more 
information on changing the CM administrator, see the Administration Guide for 
Windows. 

Router port number

During the installation process, you are prompted to supply the router port 
number. This can be any unallocated port number. If you used the Rational 
reserved port number of 5412 for Release 6.4, 6.5, or 7.0, you must choose 
another number for Release 7.1. If you did not use port number 5412, use this 
value now. TCP port number 5412 is reserved for Rational by the Internet 
Assigned Number Authority (IANA).

Installing Rational Synergy
Caution  Do not install Rational Synergy Release 7.1 over a 

previous installation. Use a separate installation directory 
for each release, or uninstall the older release first, as 
described earlier in this checklist.

Follow the instructions in the Rational Synergy Installation Guide for Windows to 
install the license server and Rational Synergy Release 7.1 on all your clients and 
servers. You should elect to create a database server during the installation. You 
may also elect to unpack a test database during the installation; that database may 
be used to test the installation.
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How the installation handles configuration, platform values, and remote execution 
files 

If your previous installation is not visible from this machine, you must merge the 
configuration files manually with those you saved. See “Backing up previous 
installation” on page 35 and “Saving previous configuration files” on page 35.
If your previous installation is visible from this machine, when you install the 
software using the procedures described above the Rational Synergy installation 
program checks the configuration files in your previous installation directory. 
The following actions are taken as a result of this check:

• Rational Synergy Release 7.1 is installed to a separate directory.

• If a previous installation directory is visible, the installer copies commonly 
modified files (such as ccm.ini) from the previous installation to the new 
one.

• The installer tells you which files must be merged:

• If a given configuration file in your previous installation directory is still 
valid for Release 7.1, it is automatically used in the Release 7.1 
installation directory.

• If a given configuration file in your previous installation directory is no 
longer valid for Release 7.1, it is copied to the Release 7.1 installation 
directory. However, it is given a different name. This new name is 
descriptive and is displayed by the installation program when you install 
Rational Synergy. If you modified any of these files in your old release 
and you want to keep the changes, simply merge your changed files with 
the new Release 7.1 configuration files.

Following is the list of configuration files that are handled as described above 
(paths are relative to the Rational Synergy installation directory):

etc/ccminit
etc/ccm.ini
etc/remexec.cfg

Creating a database server

If you did not create a database server during the installation of Rational Synergy 
7.1 on this machine, then create one now, using the ccmsrv create command. 
Follow the instructions in the Rational Synergy Installation Guide for Windows. 
Additionally, read the Rational Synergy Administration Guide for Windows before 
creating a database server. To learn how to obtain these documents, see 
“Rational documentation” on page 5.
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Post-installation
This section explains what you need to do after you have installed Rational 
Synergy Release 7.1.

Reinstalling PC integrations

If you used a PC integrations product with your previous Rational Synergy 
release, you must install the appropriate integrations release on top of Release 7.1.
You do not need to reinstall PC Integrations types into any existing databases. 
The database upgrade process described in these Upgrade Instructions preserves the 
PC integration types.

Merging your configuration files
If you have not already done so, you should merge the files identified in “How 
the installation handles configuration, platform values, and remote execution 
files” on page 41.
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Verifying the installation
Verify correct installation by unpacking a test database into the directory set up 
for Rational Synergy databases, on the database server machine. If any of the 
following steps fail, contact Contacting IBM Rational Software Support as 
described on page 2.
To verify the installation, do the following:

1. If you did not elect to unpack a test database during the installation, then you 
must now unpack a test database.

Log on as the CM Administrator on the Rational Synergy server, and unpack 
a test database. Rational Synergy databases must be on an NTFS file system, 
and the ccmdb unpack command requires a UNC path name for the 
database to be created. For more information on the ccmdb unpack 
command, refer to the Rational Synergy Administration Guide for Windows.  
> ccmdb unpack "Program 
Files\IBM\Rational\Synergy\7.1\packfiles\training.cpk" /t 
\\server\share\testdb

2. Start a Rational Synergy session in Traditional mode on the test database.

a. On the Windows taskbar, click Start > All Programs > IBM Rational 
> IBM Rational Tools > IBM Rational Synergy 7.1 to display the 
Start Rational Synergy dialog box.

Note  The Start menu folder shown in the path above is the 
default program folder. Your folder may be different 
based on where you installed the program.

When the Start Rational Synergy dialog box is displayed, enter the CM 
Administrator name and password, type the path to the test database in the 
Database Path text box, and the name of this machine in the Engine Host 
text box. Click Start to start the session.

The installation is complete when the session(s) start. Stop the sessions by 
clicking on the close icon in the top right of the Rational Synergy client window, 
or by using the Task > Exit menu item.
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Upgrade databases to Rational Synergy Release 7.1
This section explains how to upgrade your Rational Synergy databases to 
Rational Synergy Release 7.1 when using the procedure “Upgrade to a New 
Server.”

Database upgrade requirements
Before you can use your Release 6.4, 6.5, or 7.0 databases with Rational Synergy 
Release 7.1, you must upgrade these databases. Moreover, before you upgrade 
these databases, you must have installed Rational Synergy Release 7.1.
This document describes how to upgrade Rational Synergy 6.4, 6.5, or 7.0 base 
model databases – databases that have not been customized via a model install 
from a model database. Databases customized using the Type Definition dialog 
box, or by modifying control files, etc., are still considered base model databases, 
and should be upgraded using these procedures.
To upgrade model databases and databases that have been customized via a 
model install, contact IBM Rational Software Support.

Unpacking or loading previous databases

If you followed the instructions in “Creating a database server” on page 41, your 
new server is empty and ready for use. To prepare your databases for upgrade, do 
one of the following for each database that you are upgrading:

Unpacking previous database 

If you used ccmdb backup or ccmdb pack to pack your database from the 
previous release, unpack it into this new server using Release 7.1:

> ccmdb unpack packfile /to unc_database_path [-s server]

If the pack file came from a UNIX server, you must use the -w option with 
ccmdb upgrade, as described in “Upgrading base model databases to 7.1” on 
page 45.
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Loading previous database 

If you dumped the metadata for your database, and copied the file system 
portion manually as described in “Packing or dumping previous databases” on 
page 36, then you need to reconstruct the database in your new Release 7.1 
server.  The following example assumes you used the tar utility to back up and 
copy the file system portions of your database:

> ccmdb load dumpfile /to unc_database_path [-s server]
> cd database_path
> ren db db.SAVE
> "Program Files\IBM\Rational\Synergy\7.1\bin\util\bsdtar" 
xf backup_file
> ren db db.old
> ren db.SAVE db
> copy db.old\MDL_INFO db

If the dump file came from a UNIX server, you must use the -w option with 
ccmdb upgrade, as described in the next section.

Upgrading base model databases to 7.1
Perform the following steps for each Windows production database to be 
upgraded.

1. Log on to the server machine as the CM Administrator.

2. Save manual customizations.

The upgrade program automatically saves your previous pt and notify 
directories, and your previous Windows migrate.rul file.

If you made changes to other database-specific configuration files, save 
those changes by making a backup copy of the files. 

3. Run the upgrade program.
> ccmdb upgrade database_path1 databasepath2 . . . >logfile

The database_path must be supplied as a UNC path.

You can specify any number of database_path UNC paths for a list of 
databases to be upgraded. The upgrade program can take anywhere from a 
few minutes for a very small database to many hours for a very large 
database.

For more details about the upgrade program, see ”Appendix A: The 
Upgrade Program” on page 63.
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4. The upgrade program unprotects the databases. You should re-protect the 
databases, using ccmdb protect database_path, until you have 
completed the steps below and tested the result.

5. Once the database upgrade is complete, look through the logfile that you 
created in step 3 and the ccm_upgrade.log file created by the ccmdb 
upgrade command to locate any error or warning messages that require 
further action.

6. Restore manual customizations.

If you made changes to database-specific configuration files, such as triggers, 
merge the changes you saved in step 2 into the converted databases. 

Caution  You must merge these files with the Release 7.1 versions, 
not just copy back your saved versions.

7. Save the following directories to a separate directory for future reference.

The ccmdb upgrade program saves selected files from your database before 
installing the new 7.1 files. After ccmdb upgrade completes for the first item 
on a database, save these files elsewhere to prevent them from being 
overwritten by future upgrades. The saved files reside under the database 
path.

Save the content of the following directories:
• old_types
• oldbin
• oldpt
• lib/oldnotify

Save the content of the following files:
• lib/Unix/migrate.old
• lib/Windows/migrate.old

8. Modify standard types.

If any standard types were modified in the database since the previous model 
install, they are automatically exported to the 
database_path\old_types directory. Compare any modified type with 
the corresponding Release 7.1 type as follows: 

a. Start Synergy Classic and use either the CLI or the GUI.
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b. Export the Release 7.1 type using the following command:
ccm typedef /export type_name /dir to_path 

c. Compare the Release 7.1 type to the corresponding type that is in the 
database_path\old_types directory. You can do this by 
comparing XML files.

d. If you need to reapply changes, start a session on the upgraded database 
using Release 7.1, start the Type Definition dialog box and reapply the 
changes. Do not perform a type definition import of the standard type 
from a prior release into the upgraded database without examining and 
understanding all of the differences. In doing so, other properties of the 
type definition may revert to their definition from a prior release and 
these could be incompatible with Release 7.1.

9. Merge Task Attribute customizations.

Settings and possible values for some task attributes are held in the pt 
directory of your databases.

After you have used these Upgrade Instructions to upgrade a database from 
Release 6.4, 6.5, or 7.0 to Release 7.1, you have two pt directories under that 
database. To complete the upgrade, you must reapply the changes you made 
in your previous release to the new database_path\pt directory. Your 
previous pt directory was saved in database_path\oldpt.

Caution  You must merge these files with the Release 7.1 versions, 
not just copy back your saved versions.

You must also remember to restore any changes you made to the task type, 
such as adding attributes to the source_attrs attribute.
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10. Merge notify customizations.

After you have used these Upgrade Instructions to upgrade a database from 
Release 6.4, 6.5, or 7.0 to Release 7.1, you have two notify directories 
under that database. To complete the upgrade, you must reapply the changes 
you made in your previous release to the new database_path\notify 
directory. Your previous notify directory was saved in 
database_path\oldnotify.

Caution  You must merge these files with the Release 7.1 versions, 
not just copy back your saved versions. It is very 
important that you do this merge if you use Rational 
Change, because it requires modified notify scripts.

11. Set site default settings.

If you are using settings other than the default settings for the following 
options, you need to specify the defaults for your site. These settings apply 
across all sessions for all interfaces. Edit the following entries in the 
ccm.ini file to set defaults:
baseline_template
baseline_template_date_format
baseline_template_repl_char
include_required_tasks
project_subdir_template
wa_path_template

For more information about these settings, see the Defaults section of the 
Synergy CLI Help, Web mode.

12. Upgrade DCM settings.

For complete information about upgrading a DCM database, see “Upgrading 
a DCM Cluster” on page 59.

Your database is now upgraded to Release 7.1.
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Testing the database upgrade
You have completed the upgrade to your production database. To test the result, 
start a Rational Synergy session and perform a number of operations. A short list 
of operations is given below.
If the database was manually protected after the upgrade, you must unprotect it 
before you can start a session. To run your tests, unprotect the database, start up 
a session, then immediately protect the database again so that developers do not 
start to use the database until you have confirmed that it is working correctly. 
Repeat these steps each time you start a session for testing or for the 
post-upgrade actions described in the next section.
Start a Rational Synergy session on the upgraded database. On the Windows 
taskbar, click Start > All Programs > IBM Rational > IBM Rational Tools > 
IBM Rational Synergy 7.1 to display the Start Rational Synergy dialog box.
Test at least the following functionality in each upgraded database:

• Navigate through the explorers and Work pane in Rational Synergy.

• Create a new project.

• Create a task and assign it to yourself.

• Create one or more source objects in the new project.

• Check in one or more of those source objects.

• Check out one or more of the source objects you just checked in.

• View the history of one or more of these source objects.

• Use an earlier version of one of the checked-out source objects.

• Update your project, and verify that the version you used is replaced.

• Make sure you can build your own product using your normal build scripts.

• Sync your work area with your database.

See ”Appendix B: Upgrade and Synergy 7.1” on page 67 for detailed information 
about testing the upgrade.
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Post-upgrade
This section explains in detail some things you may need to do once your 
upgrade is complete.

Installing Rational Change 5.2

If you use Rational Change with this database, install Rational Change 5.2. Earlier 
releases of Rational Change are not compatible with Rational Synergy 7.1. For 
detailed instructions, refer to the Rational Change Installation Guide for Windows.
Note that you must create or upgrade at least one database before you install 
Rational Change 5.2, because Rational Change requires access to a Rational 
Synergy database.
If you use Rational Change, and if you saved a modified copy of the previous 
ptcli configuration file as described in “Saving previous configuration files” on 
page 35, you should merge it at this time. The ptcli file is:

Program Files\IBM\Rational\Synergy\7.1\etc\ptcli.cfg

DCM transfers after upgrade

Rational Synergy 7.1 supports DCM transfers to and from releases 6.4 SP1, 6.5 
SP2, 6.5a, 6.6a, and 7.0. Patches to these releases are required for DCM 
compatibility. For additional information, see the Rational Synergy Readme for 
Release 7.1 and the product README files for patches to the earlier releases.
For complete information about upgrading a DCM database, see “Upgrading a 
DCM Cluster” on page 59.

Updating work areas

If you moved the database to a new path (perhaps on a new machine) as part of 
the upgrade, existing work areas must be updated to refer to the new path. This is 
true for both copy-based and link-based work areas.  Each user of a moved 
database must run the command to update their working projects:

> ccm wa /dbpath old_database_path

Build managers must also update their prep projects, and may need to update 
shared or static projects, using the appropriate /scope options to the ccm wa 
/dbpath command.

Purposes, processes, and process rules
In Release 6.5, process rules replaced the objects previously known as update 
templates and reconfigure templates. Release 6.5 also introduced the concept of a 
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process, which is a collection of process rules, and renamed some existing 
purposes. For more information, read the "Updating Scripts to Work with 
Rational Synergy 7.1" on page 55, the Rational Synergy Help, and the Build 
Manager’s Guide.
Upgrading to 7.1 creates or renames the standard purposes. If you have modified 
any of the standard purposes, your modified copy will be renamed, starting with 
a prefix "Saved".
After the database upgrade has completed, you should examine any modified 
purposes and process rules, and adjust them as required. Create one or more 
processes with your preferred set of process rules.

Note  Rational Synergy does not replicate processes or process 
rules from 6.5 to earlier releases, nor does it replicate 
reconfigure templates or update templates from earlier 
releases to 7.1. If you used DCM to centrally administer 
update templates in earlier releases, you will have to upgrade 
all databases in the cluster to achieve the same effect with 
process rules in Release 7.1.

Disabling 6.4, 6.5, or 7.0 services
The upgrade process stopped and rendered unusable the previous release on the 
upgraded server. You should disable 6.4, 6.5, or 7.0 services using the following 
steps:

1. On the taskbar, click Start > Control Panel > Administrative Tools > 
Services to display the Services window.

2. Repeat the following steps for each 6.4, 6.5, or 7.0 Synergy service:

a. Right-click the service entry, and select Properties from the pop-up 
menu.

b. In the General tab, change the Startup type to Disabled.

Removing the previous installation
Once you no longer need your old release, you may use uninstall it if you used 
the procedure “Upgrade to a New Server” for all databases.

Caution  Do not delete the previous Rational Synergy installation 
directory if you used the procedure “Upgrade an Existing 
Server” on this machine. If you remove it incorrectly, your 
upgraded server could be compromised. For more 
information, contact “Contacting IBM Rational Software 
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Support” as explained on page 2. To learn about 
additional reasons for saving your previous installation, 
see Appendix B “B: Upgrade and Synergy 7.1” on page 
67.

Installing Windows clients
If needed, install Windows clients for Rational Synergy Release 7.1. You do not 
need to uninstall clients for previous releases, but you may do so if there is no 
need to access any databases still using the previous release.
For detailed instructions, see the Rational Synergy Installation Guide for Windows. To 
learn how to obtain this document, see “Rational documentation” on page 5.

Testing Web mode

Previous examples in this document have started Rational Synergy sessions in 
Traditional mode. If your site will start Rational Synergy sessions in Web mode, 
be sure to test that with your upgraded database. The following shows how.

1. Run the ccm monitor command and check that the appropriate CCM 
server is running. If it is not, start it using the ccm_server command. Note 
the server URL shown in the output after running the ccm monitor 
command.

2. In your browser, enter protocol://server:port/admin, where the 
protocol (http or https), server and port are those in the server URL.

3. When prompted, enter the administrator password.

4. On the Database tab, check that the database you want to test is listed as 
connected to this server. If it is shown as connected to a different server, you 
should either use the other server, or use the Web page to change the server 
for the database.

5. Start a Synergy session using the server URL you have just verified:
cmsynergy /d database_path /s server_url

Note that you can tell whether a Synergy session was started in Web mode or 
Traditional mode by looking at the lower right corner of the Synergy Work 
pane. 

You will see a message similar to the following if the session was started in 
Traditional mode: 
User sue on database /vol/ccm_docs/ccm_docs using 
server pacifica
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You will see a message similar to the following if the session was started in 
Web mode: 
User sue on database /vol/ccm_docs/ccm_docs using 
server http://cmserver:8400

Troubleshooting

If you have difficulties with a command or process, or if you receive an error 
message that you do not understand, do the following:

• Refer to the troubleshooting information on the IBM Rational Support site 
and the Rational Synergy Administration Guide for Windows, as appropriate.

These and other documents are available on the Rational Synergy Info 
Center 
(http://publib.boulder.ibm.com/infocenter/rsdp/v1r0m0/
index.jsp).

• If you still have questions, contact Contacting IBM Rational Software 
Support, as explained on page 2.

Making databases available for use
Once you have completed the upgrade, tested the results, and performed any 
required post-upgrade actions, your upgrade is complete. If you protected the 
databases during the upgrade, test, or post-upgrade process, unprotect them 
now. You should let the users know the database are ready for use, but remember 
that users’ client software must also be upgraded.
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5 Updating Scripts to Work
with Rational Synergy 7.1

Introduction
If you have written or used scripts with prior releases of Rational Synergy, you 
should review the following sections for possible changes required for those 
scripts. When reviewing your scripts, make them as portable as possible to 
minimize any changes that might be required in a future release. Rational strives to 
make the CLI upward-compatible with each release of Rational Synergy. 
However, this is not always possible when major new features or capabilities are 
provided in the new release.

New features

Rational Synergy 7.0 introduced a new CLI for use with Web mode. The new CLI 
is referred to as the Synergy CLI, and the CLI from previous releases is now 
referred to as the Classic CLI.  For more information on the Synergy CLI and 
Web mode, see the Release 7.0 Readme.  If you are interested in porting your 
existing scripts to use the Synergy CLI rather than the Classic CLI, check the 
Rational Synergy Support site for additional information. 
The Classic CLI was extended in Rational Synergy 7.1, but existing commands 
were not changed. Therefore, when upgrading from 6.5 or 7.0 to 7.1, your scripts 
should not need significant changes.  Even if your scripts do not require changes, 
you should be sure to test them carefully with 7.1.
If you are upgrading from Release 6.4, Rational Synergy Release 6.5 introduced 
new commands, new command options, and new query functions and keywords.  
While it is not always necessary to update your scripts to take advantage of these 
new features, doing so may make your scripts simpler, easier to maintain, and 
faster. Review the Readme for a description of new features in 6.5.

Changes to existing scripts
The following topics are discussed in this section:

• “Project purpose name changes” on page 56

• “Process rules and reconfigure/update templates” on page 56
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Project purpose name changes
In Release 6.5, project purposes were renamed, as shown in the table below. 
Additionally, in Release 7.0, the name project purposes was changed to purposes. You 
should update your scripts to use the new purpose names.

If a script creates a new release specifying a set of purposes, the script must at the 
minimum be updated to use the correct new names. You should consider 
changing these scripts to specify the process for the new release. A process 
defines a set of process rules, which replaces the objects previously known as 
reconfigure templates or update templates. For more information on processes 
and process rules, see the ReadMe and the Build Manager’s Guide.

Process rules and reconfigure/update templates
In Release 6.5, process rules replaced the objects previously known as update 
templates. The commands ccm update_template, ccm update_temp, and 
ccm ut from 6.4 are still available, but they are now aliases to the preferred form 
of the command: ccm process_rule or ccm pr. You should update your 
scripts to use the new form of the command.
The combination of release and purpose no longer forms a unique identifier for 
process rules, so the old form of reconfigure template or update template 
specifiers release:purpose is not used in the ccm process_rule command. 
You must update your scripts to use the new form of process_rule_spec. For more 
information, see the Rational Synergy CLI Help, Web mode.
Process rules no longer support direct task members; you must enclose all tasks 
with folders or folder templates. For this reason, the following command forms 
are no longer supported, and you must remove them from your scripts:

ccm project_grouping -show individual_tasks
ccm update_template -tasks [-y] [-related] (and all its aliases)
ccm update_template -show tasks (and all its aliases)

The -copy option may no longer be used to create process rules, but only lets 
you copy over an existing process rule, and no longer accepts the -force 
option.

Old Purpose Name New Purpose Name

Custom Custom Development

Shared Shared Development

Visible Visible Development

Master Integration Master Integration Testing
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Process rules and reconfigure/update templates
Process rules no longer have a DCM transfer option (they are always allowed to 
be transferred), and so the following command forms are no longer supported:

ccm update_template -allow_dcm_transfer
ccm update_template -noallow_dcm_transfer
ccm update_template -show allow_dcm_transfer
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6 Upgrading a DCM Cluster

Introduction
This chapter describes additional upgrade considerations when upgrading one or 
more databases that participate in a DCM cluster. If you are not using DCM or 
are upgrading a database that is not initialized for DCM, then you may skip this 
chapter.
Note that in Release 7.0, the product name Distributed CM was changed and is 
now Rational Synergy Distributed. The product abbreviation remains DCM.

Compatibility with prior releases of Rational Synergy
Rational Synergy 7.1 supports DCM transfers to and from releases 6.4 SP1, 6.5 
SP2, 6.5a, 6.6a, and 7.0. Patches to these releases are required for DCM 
compatibility. For additional information, see the Rational Synergy Readme for 
Release 7.1 and the product README files for patches to the earlier releases.
With these patches, DCM in Rational Synergy Release 7.1 is compatible with 
Rational Synergy Releases 6.4 and 6.5. If you want to exchange data with releases 
prior to 6.4, you must do so through an intermediate database.
In general, when a transfer package is generated from a Rational Synergy Release 
7.1 database, not all data and information may be processed in earlier releases. 
The additional data will be ignored by prior releases. However, that will also mean 
that only a subset of the data will be represented in prior releases and not all of 
the 7.1 features and benefits may necessarily apply across a DCM cluster when 
some databases are at prior releases. To gain full benefit from Release 7.1, all of 
the databases in a DCM cluster should be upgraded to 7.1.
Note that Rational Synergy does not replicate processes or process rules from 7.1 
to 6.4, nor does it replicate reconfigure templates or update templates from 
Release 6.4. If you used DCM to centrally administer update templates in earlier 
releases, you will have to upgrade all databases in the cluster to achieve the same 
effect with process rules in Release 7.1.

Order of upgrading a DCM cluster
To get the full benefit of the new functionality in Rational Synergy Release 7.1, all 
databases in the DCM cluster should be updated before resuming DCM 
operations and regular usage. However, when these databases are located at 
different sites or when a large number of databases are in the cluster, it may not be 
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practical to upgrade them all at one time. There may thus be some time when 
some of the cluster has been upgraded to 7.1 and some is at one or more prior 
releases.
There are several factors that determine the order in which sites and/or 
databases should be upgraded:

• Hub databases should be updated before the spoke databases that exchange 
data with them. After a hub database is updated, as each spoke database is 
upgraded, it will be able to fully use the new facilities in Release 7.1. 
Conversely, if two Release 7.1 databases share data via a pre-7.1 hub 
database, all three databases will be constrained by the reduced functionality 
of the hub database.

• In Master and Satellite DCM methodology, the master database is where 
master builds are performed and applications are released. It is preferable to 
update the master database first, though the satellites must also be upgraded 
before process rules can be shared, as noted in “Replicating releases, 
templates and process rules” on page 61.

Steps to perform after upgrading a database in a DCM cluster
The following sections describe the steps to be completed after you upgrade a 
database in a DCM cluster.

• “DCM database definitions in the upgraded database” on page 60

• “DCM database definition for this database in other databases” on page 61

• “Replicating releases, templates and process rules” on page 61

DCM database definitions in the upgraded database

After a database has been upgraded, you should review the DCM database 
definitions in the upgraded database and establish which Rational Synergy 
release it is currently using.

Release 7.1 does not support the old CCM45SP2 export format. Existing 
database definitions that used the CCM45SP2 format will have the generate 
allowed property turned off, and messages indicating this will be shown in the 
upgrade log. If these databases have been upgraded to 6.4, 6.5, or 7.0, and 
now use the XML export format, you can re-enable generate allowed.

Similarly, Release 7.1 does not support mapping project instances to or from 
1. Existing database definitions that had map project instances turned on will 
have the generate allowed property turned off, and messages indicating this will 
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be shown in the upgrade log. If these databases have been upgraded to 6.4, 
6.5, or 7.0, you can re-enable generate allowed.

Last, the handover database setting was retired in Release 7.0. A unique 
replication path between databases is no longer required. Instead, a new 
handover allowed control allows you to define whether that database appears as 
a valid handover database in dialog boxes.

DCM database definition for this database in other databases

After upgrading a database to Release 7.1 from Release 6.4, 6.5, or 7.0, you 
must update the DCM database definitions for that database in all the other 
databases in the DCM cluster that have a definition for it. In the case of 
databases at other geographic sites, you should contact the administrators at 
the sites and advise them of the changes required. You should ensure that 
these changes have been performed before resuming DCM replication 
between the upgraded database and those other databases.

These are the checks and steps you or the remote administrator should 
perform:

1. Verify that all databases in the cluster that can replicate directly or 
indirectly with the upgraded 7.1 database have themselves been 
upgraded to 7.1, or are running 6.4 with the required patches or 6.5.

2. If you have moved the database to a new location, verify that the 
database path in the DCM database definition is updated to reflect the 
new location.

3. If you have used auto-receive, verify that the CCM_HOME setting is 
updated to reflect your new Release 7.1 installation directory.

Replicating releases, templates and process rules

In releases of Rational Synergy prior to 6.5, all release definitions and templates 
that were allowed to be transferred using DCM were sent with all transfer sets 
that included releases.
In Releases 7.0 and 7.1, transfer sets have a release scope and a release query to 
control the inclusion of release definitions, together with their associated release-
specific process rules and templates. If you upgrade your database from 6.4 or 
6.5, the previous settings on the transfer sets were converted to the new scope to 
ensure compatibility. However, because it is now possible to exert more control 
over the transfer of releases and templates, you may want to adjust these settings 
accordingly.
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To replicate generic process rules, you can either add them as direct members to 
a transfer set, or add a process definition to the transfer set.

Note  Rational Synergy does not replicate processes or process rules 
from 7.1 to 6.4; if you want to use these new features in a set 
of databases, you must upgrade all those databases to Release 
7.1.

For more information on the new features, see the Readme and the Rational Synergy 
Distributed document.

DCM replication after upgrade
The upgrade to Release 7.1 is designed to minimize touching the 
modify_time of objects. DCM transfer packages generated immediately after 
upgrade may be slightly larger than normal, but this is not normally expected to 
cause noticeable impact to regular operation.
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Appendix A: The Upgrade Program
This appendix describes the Rational Synergy upgrade program, ccmdb 
upgrade.

Command name
ccmdb upgrade

Synopsis
ccmdb upgrade

[/f model_file]
[/m] model [model ...]]
[/w] [/url server_url]
database_path [database_path ...]

Role
You must be the CM Administrator to run this command, and you must be 
logged on to the database server machine.

Description and uses
The upgrade program converts a database from Releases 6.4, 6.5, or 7.0 to Release 
7.1. You must upgrade a database from a previous release before using it with 
Release 7.1.

Note  This command does not support individual model installs.

The database to be upgraded must be on a Release 7.1 database server, either by 
upgrading a previous server, or by first being packed or dumped from the 
previous server running the previous release, then unpacked or loaded into a 
Release 7.1 server.
The following is an example of how to upgrade the two databases 
\\elite\ccmdbs\production1 and \\elite\ccmdbs\testdb to 
Release 7.1, using the default model file. Log on to elite as the CM 
Administrator, open a command window, and then issue the following command:

> ccmdb upgrade \\elite\ccmdbs\production1 
\\elite\ccmdbs\testdb
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Options and arguments
/f model_file

This option specifies the model package file name. 

If you do not specify the model file, the Rational Synergy default model 
name CCM_HOME\packfiles\base.model is used. Use of non-
standard models is not described in this document.

This option  must be a UNC path.
/m model [model ...]

This option specifies the list of model names to be installed. The model 
name is the same name as the model project name in the model database. 
The default models shipped by Rational Synergy are the base and 
modsup models. 

Note  Each model in the model file must have a unique name.

If this option is not specified, ccmdb upgrade will read the models 
that are currently installed on each databases and upgrade them 
accordingly. 

If this option is specified, the new list will be used to override the current 
models. The sequence of the models listed in this option is the sequence 
of the models to be installed in the target database. All the current 
models that are not in the specified list will be removed. As a result, 
specifying the option /m base will cause the database to be upgraded to 
a Rational base model, removing all custom models present in a previous 
release.

/url server_url

This option specifies the CCM server that the upgraded databases 
should connect to. By default, upgraded databases are connected to the 
server on the default port of the database server host. The default port is 
the one you specified as the help server port during installation. It is 
saved in the $CCM_HOME/etc/system_info.txt file. 

To start a Rational Synergy session in Web mode on a database, enter 
cmsynergy /s server_url.

Ensure that the server_url is a valid URL for a compatible server, 
starting with either http:// or https://

See "About the CCM server" in the appropriate Rational Synergy 
Administration Guide for a detailed discussion about the CCM server.
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/w 

This option checks all database configuration files and controlled files of 
type ascii or its subtypes and converts the line endings from Windows 
to UNIX conventions or vice versa while performing the upgrade. The 
conversion affects controlled files in the archive and cache only; no 
work areas are updated.

Caution  Because this operation changes the contents of 
static, archived files, it should be used with 
caution. Always retain the original pack file in 
case any problems are discovered.
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database_path [database_path ...]

This option specifies the list of databases to be upgraded.

These must be UNC paths to databases on the server where you are 
logged on.

Upgrade actions
The upgrade program then performs the following actions on each database that 
it upgrades:

1. Updates the target database schema to the Release 7.1 schema.

2. Updates the target database version to 7.1.

3. Saves the previous migrate rules as 
database_path\lib\Windows\migrate.old.

4. Saves the previous pt directory as database_path\oldpt.

5. Saves the previous notify directory as 
database_path\lib\oldnotify.

6. Protects the target database.

7. Exports any types that were modified in the target database.

8. Finds the list of models installed in the target database.

9. Installs the required list of models and model additions from the model 
database to the target database.

10. Unprotects the target database.

11. Restores the original migrate rules file saved in step 3, and performs any 
upgrade that is required.

12. Starts a 7.1 session on the target database.

13. Runs the ccm db_update /update command to update the data in the 
target database to Release 7.1 format.

14. Converts line end conventions in ASCII files if the /w option was present.

15. Check the archive conversion status.

16. Removes obsolete files from the target database.

17. Connects the database to the default CCM server, or to the CCM server 
specified by the /url option.
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Appendix B: Upgrade and Synergy 7.1
This section discusses special considerations for upgrading to Synergy Release 
7.1.
Rational Synergy 7.1 has many changes to underlying utilities that could affect 
your usage.  Before upgrading, review the next section, “Changes in Rational 
Synergy 7.1”.
Note that after you have upgraded your database to Synergy 7.1, you can perform 
an archive conversion. The timing of the conversion is flexible; learn more about 
this in “C: Archive Conversion” on page 75.

Changes in Rational Synergy 7.1
This section is a summary of changes in Rational Synergy 7.1 that you should take 
into account when planning your upgrade.  These changes require additional 
testing beyond the testing you have done for previous releases.

• ActiveCM™ is not available in Synergy 7.1.  This includes the following 
features:

• Windows Explorer interface, included with ActiveCM
• Windows Taskbar interface, included with ActiveCM
• ActiveCM's file monitoring feature

• ObjectMake (ccm_make) and the pre-processor program (ccm_cpp) were 
removed from the product. If your build process depends on ObjectMake, 
you can continue to use it in Synergy 7.1 by following the instructions in this 
appendix. If you choose to do so, you should test that you are able to build 
your files with Synergy 7.1 before upgrading.

• Rational Synergy 6.5 and earlier used GNU RCS and zip to archive checked-
in files. Releases 7.0 and 7.1 contain different versions of those utilities. 
Release 7.1 still uses those utilities to read old archives, but also provides a 
different mechanism to archive new checked-in files.

This change is transparent to all users. However, Rational has provided a 
utility for testing your archives from 6.4 or 6.5 to ensure the new utilities can 
read them. Test that the archives are readable for all existing databases before 
upgrading to Synergy 7.1; instructions for testing archives are provided in this 
appendix.

Additionally, you can use the new web interface, Synergy Web Administration 
Interface, to convert old archives to the new 7.1 format. Note that the 
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conversion is optional in Synergy 7.1, and might result in the use of more 
disk space. See Appendix “C: Archive Conversion” on page 75.

If you find issues when you test your archives, you will be able to continue to 
use the rcs utilities from Synergy 6.5 SP2 in Synergy 7.1 by following the 
instructions in this appendix.

• The underlying utilities used for creating and retrieving data from pack files, 
DCM packages, and Save Offline (SOADF) packages have changed. Synergy 
uses tar/untar and zip/unzip utilities to package multiple files into a 
single, compressed file for these operations. Synergy 7.1 contains different 
versions of these utilities.

This change is transparent to all users and administrators.  However, you 
should test existing pack files, DCM packages, and Save Offline packages 
that were created in a previous release to ensure that the new utilities can 
read those files. Instructions for testing those files are provided in this 
appendix.

• The underlying utilities used for compare and merge from Rational Synergy 
Classic CLI, and automated merge from the Classic GUI, have changed. 
Synergy uses diff, diff3, and mrge utilities for these operations, and 
Release 7.1 contains different versions of these utilities.

This change should be transparent to all users and administrators.  However, 
it is possible that the results of certain merges may differ, because there are 
sometimes several accurate ways in which conflicts can be resolved 
depending on how the merge utility analyzes character patterns between files.

If you find issues when you test your data, you will be able to continue to use 
the old compare and merge utilities from Synergy 6.5 SP2 in Synergy 7.1 by 
following the instructions in this appendix.

The following summary outlines issues to consider before upgrading to Release 
7.1

1. Carefully test the following areas before upgrading to Synergy 7.1.

• All pack files created using Release 6.5 or 6.4 that you intend to use with 
Synergy 7.1

• All archived data checked in while running previous releases
• All DCM packages created using Releases 6.5 or 6.4 that you intend to 

use with Synergy 7.1 or follow-on releases
• All Save Offline (SOADF) packages created in previous releases that you 

intend to use with Synergy 7.1 or follow-on releases
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• ObjectMake, if you depend on it 

For detailed information, see “Testing your data” on page 69.

2. You can copy ObjectMake and the utilities used in Synergy 6.5 SP2 for 
archiving checked-in files to be used in 7.1. See “Copying ObjectMake and 
utilities from Release 6.5” on page 71.

Testing your data
This section provides instructions for testing pack files, archived data, DCM 
packages, Save Offline packages, and ObjectMake. 
All of these tests require you to first install Synergy 7.1 for testing purposes.  
Be sure to test your data in a non-production environment before upgrading.
Except for the last step (testing ObjectMake), you should do all of these tests 
before copying ObjectMake and utilities from Release 6.5 into your Synergy 7.1 
installation, as described in “Copying ObjectMake and utilities from Release 6.5” 
on page 71.

Testing pack files
Test your pack files as follows.

1. You must have installed Synergy 7.1 for testing purposes.

2. For each 6.4 SP1 or 6.5 SP2 pack file, unpack it in Release 7.1 using the 
ccmdb unpack command.

3. If the ccmdb unpack command reports any issues, report them to IBM 
Rational Software Support for guidance.

Testing archived data

To test your archived data, Synergy 7.1 includes a new command called ccm 
archive_check.

1. You must have installed Synergy 7.1 for testing purposes.

2. For each 6.4 SP1 or 6.5 SP2 database, complete the following:

• Upgrade a test copy of the database to Release 7.1.
• Run the ccm archive_check command on the database. Usage is 

described in “Checking contents of archive with ccm archive_check” on 
page 72

3. If the ccm archive_check command reports any issues, report them to 
IBM Rational Software Support.
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If the ccm archive_check reports issues, copy the archiver utilities from 
Release 6.5 into your Synergy 7.1 installation, as described in “Copying 
ObjectMake and utilities from Release 6.5” on page 71.

Testing DCM packages

Test your DCM packages as follows.

1. You must have installed Synergy 7.1 for testing purposes.

2. For each DCM package, complete the following:

• Upgrade a test copy of the receiving database to 7.1.  (You may have 
done this already when testing archived data.)

• Receive the DCM packages, in order.

3. If the DCM receive reports any issues, report them to IBM Rational 
Software Support for guidance.

Testing Save Offline (SOADF) packages
Test your Save Offline packages as follows:

1. You must have installed Synergy 7.1 for testing purposes.

2. For each Save Offline package, complete the following:

• Upgrade a test copy of the restoring database to 7.1.  (You may have 
done this already when testing archived data.)

• Restore the packages, in order.

3. If the restore reports any issues, report them to IBM Rational Software 
Support for guidance.

Testing ObjectMake

To test ObjectMake, you must have an installation of Synergy 6.5 SP2 with patch 
6.5 SP2 01, or its replacement, applied. Patch 6.5 SP2 01 includes an important 
change to ObjectMake that you will need in order to use ObjectMake with 
Release 7.1.
If you are running Synergy Release 6.4, you do not need to upgrade your data to 
release 6.5 SP2.  However, you do need to install 6.5 SP2 with patch 6.5 SP2 01, 
so that you can access files from that installation.
Test ObjectMake as follows:

1. You must have installed Synergy 7.1 for testing purposes.
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2. You must have installed Synergy 6.5 SP2 and applied patch 6.5 SP2-01, as 
described above.

3. Copy the ObjectMake programs from the 6.5 SP2 installation to the 7.1 
installation as described in “Copying ObjectMake and utilities from Release 
6.5” on page 71. (You may have already done this in the previous procedure, 
“Testing your data” on page 69.)

4. For each database where you use ObjectMake, complete the following:

• Upgrade a test copy of the database to 7.1.  (You may have done this 
already during an earlier step.)

• Build your products, ensuring that ObjectMake works as it did in 
previous releases.

5. If you encounter any issues, report them to IBM Rational Software Support 
for guidance.

Copying ObjectMake and utilities from Release 6.5
 If you rely on ObjectMake, or if you find issues when testing with Release 7.1 as 
described in the section “Testing archived data” on page 69, you can copy 
ObjectMake and other utilities from a previous release.

Note  If you are still running Release 6.4, you must install Synergy 
Release 6.5 SP2 and apply patch 6.5 SP2 01, or its 
replacement. This includes changes to ObjectMake that are 
required to use the program with Release 7.1. You do not 
need to upgrade your databases to Release 6.5 SP2, but you 
do need an installation directory containing 6.5 SP2 with 
patch 1 applied.

To copy ObjectMake and utilities, complete the following:

1. You must have installed Synergy 7.1.

2. You must have installed Synergy 6.5 SP2 and applied patch 6.5 SP2-01.

3. Log in as user ccm_root.

4. Enter the following command:
ccm_copy_tools old_install_dir new_install_dir

The ccm_copy_tools command supports several variations. You can use it to 
save a copy of the utilities from a previous installation for future use, and to 
apply a saved copy of the utilities to Synergy 7.1. Even if you do not intend to 
Rational Synergy Upgrade Instructions, Release 7.1  71

https://support.telelogic.com/synergy" TARGET = "new page


Appendix 
copy the utilities into your 7.1 installation, it is a good idea to save a copy of them 
from your Synergy 6.5 installation.
See the section “Copying utilities with ccm_copy_tools” on page 73 for more 
information about this program.

Checking contents of archive with ccm archive_check
Use the new ccm archive_check command to check the contents of the 
archive within a Synergy database. It will confirm that all of the source files 
archived using a previous release, such as Synergy 6.5, can be retrieved 
successfully using the new archive utility in Synergy 7.1.  
You can check all archived files, only files of a particular type, or specific files.
To run this command, you must first install Synergy 7.1. Users must be in the 
ccm_admin role to use this command.
To test archive files on a database that has already been upgraded to 7.1, run the 
command using the syntax described below.

1. Start a Classic CLI session on the older database.

2. Enter the following commands:
ccm set role ccm_admin

ccm archive_check ...

The following describes the command syntax.
ccm archive_check [/t|/type type]|[file_spec...] 
[/gnu gnu_dir] [/bsd bsd_dir]

/bsd bsd_dir

Specifies the Synergy installation directory where the BSD executables 
(bsdci, bsdco, bsdrcs, bsdlog, ccm_zip, and ccm_unzip) exist. The 
default is $CCM_HOME/bin/util/. You should not need to specify this 
argument if you are running this command in your Synergy 7.0 installation.

file_spec

Indicates a specific file or set of files whose archive you want to check.
/gnu gnu_dir

Specifies the Synergy installation directory where the GNU executables 
(ccm_gci, ccm_gco, ccm_glog, ccm_grcs, and ccm_gzip) exist. The 
default value is CCM_HOME\bin\util, but if you have not copied the 
utilities from a previous release using the ccm_copy_tools command, you 
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should specify the path to the bin\util directory in your Synergy 6.4 or 
6.5 server installation directory.

/type|/t

Indicates to check files of the specified type only.  If you have a very large 
database, this command enables you to check subsets of data in separate 
commands.

Examples

• Check all archives in the current Synergy 7.1 database, using the GNU 
utilities from the Synergy 6.5 SP2 installation.
ccm archive_check /gnu \\irv\ccm\ccm65sp2\bin\util\

• Check all archives for objects of the type java in the current Synergy 7.1 
database, using the GNU utilities from the Synergy 6.5 SP2 installation.
ccm archive_check /gnu \\irv\ccm\ccm65sp2\bin\util\ 
/t java

• Check the archives for version 14 of main.c in the current Synergy 7.1 
database, using the GNU utilities from the Synergy 6.5 SP2 installation.
ccm archive_check /gnu \\irv\ccm\ccm65sp2\bin\util\ 
main.c-14

Copying utilities with ccm_copy_tools
This is a script that copies utilities from a Synergy 6.5 or 7.0 installation directory 
to the Synergy 7.1 installation directory. Alternatively, you can use it to save the 
utilities from a previous release, or apply previously saved utilities into a Synergy 
Release 7.1 installation.
This command must be run as user ccm_root because it must be able to write to 
your Synergy 7.1 installation directory.

Note  The client uses ObjectMake and diff/merge tools. As a result, 
you must update each client installation using 
ccm_copy_tools, as well as the server installation. The 
client installation only needs the ObjectMake and diff/merge 
tools (ccm_copy_tools -m and -d), but it is harmless to 
copy the archive tools to the client installations as well.

The following describes the command syntax.
ccm_copy_tools old_installation_dir new_installation_dir
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In this form of the command, 6.5 tools are copied directly from the old 
Synergy installation directory to the new one. 

You will see an error in the following cases:

• Either of the two installation directories does not exist.
• The two installation directories refer to the same directory. 
• The old installation directory is not from Synergy 6.5 or later.
• The new installation directory is not from Synergy 7.0 or 7.1. 

Note that it is legal for the old_install_directory to refer to an 
existing Synergy 7.0 or 7.1 directory that was previously updated with 6.5 
tools; this makes it possible to copy tools from one 7.1 installation to 
another, or from a 7.0 installation to a 7.1 installation, and so forth.

ccm_copy_tools -o output_file old_install_dir

This form of the command copies 6.5 tools from an existing Synergy 6.5, 
7.0, or 7.1 installation to a saved file for later installation elsewhere. This is 
useful when the previous and new Synergy installations are not visible to 
each other, so the direct copying performed in the previous form of the 
command cannot be used.

ccm_copy_tools -i input_file [new_install_dir]

This form of the command copies 6.5 tools from a saved file into an existing 
Synergy 7.0 or 7.1 installation. The saved file must have been produced by an 
earlier use of the ccm_copy_tools -o command. You'll see an error if the 
new installation directory is not from Synergy 7.0 or 7.1.

In all modes, you can also use the following options:

-a Copy the tools used for archiving.

-m  Copy the files used for ObjectMake.

-d  Copy the tools used for diff and merge.

-v  Show the path to each file as it is copied.

The default is to copy files needed for all purposes.
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This section discusses archive conversion in Synergy Release 7.1. The following is 
the flow of procedures:

• Complete the upgrade from 6.4, 6.5, or 7.0 to Release 7.1.

• Complete the steps in “Ensuring that archived data is readable” on page 76.

• Complete the steps in “Checking for file system archive errors” on page 77.

• Complete the steps in “Starting the Rational Synergy Web Administration 
Interface” on page 78.

• Complete the steps in “Running the archive conversion” on page 78.

Understanding archive conversion
Archive conversion is the process of reading older archives produced by GNU or 
BSD archivers, and writing new archives in the 7.1 format. The archive 
conversion process deletes old archive files and directories as it converts archives.
Rational provides a Synergy Web Administration Interface that you can use to 
start, stop, and report on the progress of archive conversion. 

When to perform archive conversion
Archive conversion is optional in Synergy 7.1.
You can perform archive conversion any time after you upgrade your Rational 
Synergy database to Release 7.1.
The advantages of converted archives include the following:

• The ccm fs_check command uses less memory to find unused converted 
archives.

• Converted archives hold more information to aid recovery in the event of 
database corruptions, disk crashes, and similar events.

In some cases, a database might consume more disk space after archive 
conversion in Synergy 7.1. A future release will reduce the space taken by archives; 
for this reason, you might want to postpone archive conversion until a later 
release.
The CM administrator must run the ccm fs_check command and resolve any 
reported errors before attempting archive conversion.
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Preparing for archive conversion
In preparation for archive conversion, first check if you need to run the ccm 
archive_check command, which is described in “Ensuring that archived 
data is readable” below. Next, see “Checking for file system archive errors” on 
page 77 for information about running the ccm fs_check command, which 
is mandatory prior to performing archive conversion.

Ensuring that archived data is readable

The ccm archive_check command checks archived data to ensure that it is 
reabable.
You will need to run the ccm archive_check command if your site ran 
Rational Synergy on 6.x, or 7.0 with ccm_copy_tools, or runs 7.1 without 
using ccm_copy_tools. See “Checking contents of archive with ccm 
archive_check” on page 72.
Rational Synergy users will fall into one of the following categories. However, 
note that regardless of the category, once a site has run a complete archive 
conversion, neither the GNU nor BSD archiving tools will be used, and ccm 
archive_check is no longer required.

• Sites that upgrade from releases before 7.0 and do not use 
ccm_copy_tools

Run ccm archive_check to ensure your existing GNU archives from 
6.x are readable by the BSD archiver in 7.0 and 7.1.

• Sites that upgrade from 7.0 to 7.1 and who drop use of ccm_copy_tools

If your site used ccm_copy_tools in Synergy 7.0 to copy the GNU 
archivers, your site might have old GNU archives from 6.x and will also have 
new GNU archives produced by the copied archiver in 7.0. If you decide not 
to copy the GNU archiver forward to 7.1, the BSD archiver will be used to 
read these GNU archives. Use ccm archive_check to ensure the 
archives are readable.

There is no need to run ccm archive_check in the following situations:

• Sites that upgrade to 7.1 and start or continue use of ccm_copy_tools

These sites may have a mix of GNU, BSD, and 7.1 archives. However, each 
archive will be read by the corresponding tool, so there is no need to run 
ccm archive_check.

• Sites that were new Synergy users in 7.0 and never used 
ccm_copy_tools
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These sites will have only BSD and 7.1 archives. Because there are no GNU 
archives, there is no need to need to run ccm archive_check.

• Sites that are new Synergy users in 7.1

These sites will have only 7.1 archives. There are no GNU archives, so there 
is no need to need to run ccm archive_check.

Checking for file system archive errors

The ccm fs_check command is responsible for checking that the metadata, 
cache, and archive portions of a database are consistent. The following are three 
reasons why file system checks are important to you.

• In Release 7.1, if a static versioned object does not have an archive, this 
means that the archiver has not yet processed that object. This is normal 
behavior and is not typically treated as an error.

• If an object has been static without an archive for a longer time than 
specified by a user, this indicates a possible problem because the archiver 
might not be running. You will receive a warning. 

The ccm fs_check command has a new -c|-cutoff_time time 
option. Any object versions checked in before the cutoff time but not yet 
archived produce a warning. The default cutoff is -2:0:0:0. You will receive a 
warning for any files that were checked in earlier than the day before 
yesterday but have not yet been archived.

• After archive conversion is complete, the check for unused archive files now 
uses less memory than in Release 7.0 and earlier.
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Archive conversion
The following discussion details how to convert archived data using the Rational 
Synergy Web Administration Interface. You must be a CM administrator to run 
an archive conversion.

Starting the Rational Synergy Web Administration Interface
1. Open a browser.

2. Enter http://server:port/admin

where server:port is the server and port number on which the Rational 
Synergy Web Administration Interface resides, for example, 
http://usir-sol2:8400/admin

To view the URL for CCM servers, use the ccm monitor command.

Running the archive conversion

1. In the Rational Synergy Web Administration Interface, click the middle tab, 
Archive Conversion.

You will see a list of databases that need converting and the status of each 
archive conversion. The far right column contains a button to start or stop 
conversions, or to remove databases that no longer need to be converted.

2. Start archive conversion for a database by clicking the Start button. The 
button will change from Start to Stop, and the status will change to 
Initializing while the conversion program queries for objects that 
need to be converted. This initial query can take several minutes.

3. You can stop archive conversion for a database at any time by clicking the 
Stop button. The button will change from Stop to Start; the next time you 
start conversion, it will continue from where it left off.

4. While the archive conversion is running, you will have to manually refresh 
the browser to view updated information, such as the total number of 
objects to be converted, the number remaining, and the percentage 
complete.

5. If archive conversion fails to convert all archives, the status column will show 
an Error link. Errors during conversion require you to contact IBM Rational 
Synergy Support. Clicking the Error link will add information to the page, 
such as the number of errors, a list of the objects that failed to be converted, 
and a link to the IBM Rational Synergy Support site.
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6. Once archive conversion has completed, the button will change to Remove.  
Click the Remove button to remove the row for this database from the 
archive conversion tab of the Rational Synergy Web Administration 
Interface. 

If the database is not removed, but persists with the button changed to 
Start, the archive conversion is not complete. Check for errors as described 
above in step 5 on page 78, and run the command ccm fs_check as 
described in “Checking for file system archive errors” on page 77.

7. Exit the Rational Synergy Web Administration Interface at any time by 
clicking the Logout link to the right of the tabs.

If you have previously run ccm clean_cache on a database, archive 
conversion will extract the previously deleted cache files from the old archives in 
preparation for archiving them with the new archiver. As a result, the database 
might occupy more disk space. After archive conversion is completed, you might 
want to run ccm clean_cache again to recover this space. In some cases, 
you might need to run ccm clean_cache repeatedly while the archive 
conversion is in progress, if you are short of disk space for the database cache.
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Appendix D: Notices
© Copyright 1992, 2009
U.S. Government Users Restricted Rights - Use, duplication, or disclosure 
restricted by GSA ADP Schedule Contract with IBM Corp.
This information was developed for products and services offered in the U.S.A. 
IBM® may not offer the products, services, or features discussed in this 
document in other countries. Consult your local IBM representative for 
information on the products and services currently available in your area. Any 
reference to an IBM product, program, or service is not intended to state or imply 
that only that IBM product, program, or service may be used. Any functionally 
equivalent product, program, or service that does not infringe any IBM 
intellectual property right may be used instead. However, it is the user's 
responsibility to evaluate and verify the operation of any non-IBM product, 
program, or service.
IBM may have patents or pending patent applications covering subject matter 
described in this document. The furnishing of this document does not grant you 
any license to these patents. You can send written license inquiries to: 

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A. 

For license inquiries regarding double-byte character set (DBCS) information, 
contact the IBM Intellectual Property Department in your country or send 
written inquiries to: 

IBM World Trade Asia Corporation
Licensing
2-31 Roppongi 3-chome, Minato-ku
Tokyo 106-0032, Japan 

The following paragraph does not apply to the United Kingdom or any 
other country where such provisions are inconsistent with local law: 
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES 
THIS PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, 
EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, 
THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, 
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MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. 
Some states do not allow disclaimer of express or implied warranties in certain 
transactions. Therefore, this statement may not apply to you. 
This information could include technical inaccuracies or typographical errors. 
Changes are periodically made to the information herein; these changes will be 
incorporated in new editions of the publication. IBM may make improvements 
and/or changes in the product(s) and/or the program(s) described in this 
publication at any time without notice. 
Any references in this information to non-IBM Web sites are provided for 
convenience only and do not in any manner serve as an endorsement of those 
Web sites. The materials at those Web sites are not part of the materials for this 
IBM product and use of those Web sites is at your own risk. 
IBM may use or distribute any of the information you supply in any way it 
believes appropriate without incurring any obligation to you. 
Licensees of this program who wish to have information about it for the purpose 
of enabling: (i) the exchange of information between independently created 
programs and other programs (including this one) and (ii) the mutual use of the 
information which has been exchanged, should contact: 

Intellectual Property Dept. for Rational® Software
IBM Corporation
1 Rogers Street
Cambridge, Massachusetts 02142
U.S.A.

Such information may be available, subject to appropriate terms and conditions, 
including in some cases, payment of a fee. 
The licensed program described in this document and all licensed material 
available for it are provided by IBM under terms of the IBM Customer 
Agreement, IBM International Program License Agreement or any equivalent 
agreement between us. 
Any performance data contained herein was determined in a controlled 
environment. Therefore, the results obtained in other operating environments 
may vary significantly. Some measurements may have been made on 
development-level systems and there is no guarantee that these measurements 
will be the same on generally available systems. Furthermore, some 
measurements may have been estimated through extrapolation. Actual results 
may vary. Users of this document should verify the applicable data for their 
specific environment. 
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Information concerning non-IBM products was obtained from the suppliers of 
those products, their published announcements or other publicly available 
sources. IBM has not tested those products and cannot confirm the accuracy of 
performance, compatibility or any other claims related to non-IBM products. 
Questions on the capabilities of non-IBM products should be addressed to the 
suppliers of those products.
This information contains examples of data and reports used in daily business 
operations. To illustrate them as completely as possible, the examples include the 
names of individuals, companies, brands, and products. All of these names are 
fictitious and any similarity to the names and addresses used by an actual 
business enterprise is entirely coincidental. 
If you are viewing this information softcopy, the photographs and color 
illustrations may not appear. 

Trademarks

IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of 
International Business Machines Corp., registered in many jurisdictions 
worldwide. Other product and service names might be trademarks of IBM or 
other companies. A current list of IBM trademarks is available on the Web at 
www..ibm.com/legal/copytrade.html.
Linux is a registered trademark of Linus Torvalds in the United States, other 
countries, or both. 
Microsoft, Windows, Windows NT, and the Windows logo are trademarks of 
Microsoft Corporation in the United States, other countries, or both.
UNIX is a registered trademark of The Open Group in the United States and 
other countries. 
Java and all Java-based trademarks and logos and Solaris are trademarks of Sun 
Microsystems, Inc. in the United States, other countries, or both. 
Other company, product or service names may be trademarks or service marks 
of others.
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